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Creating a project with a hybrid application

Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view

Deploying and previewing
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New Worklight Project

= Create an IBM Worklight®
project: in the toolbar, click
Create a Worklight Artifact >
Worklight Project

= Other ways to create an IBM
Worklight project:

— Click File > New > Project >
Worklight Project > Next.

— Right-click an empty space in
the Project Explorer, and
click New > Worklight
Project.
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0 0

A

W R (¢ X RN C e 7 R

L5 Project Explorer  Worklight Adapter

b = Worklight Dewvell
[ Worklight Hybrid Application

B Worklight Inner Application
[@] Worklight Shell Component
L] Worklight Native API

BB Worklight Environment
&= Worklight Application Skin

£4 Worklight JSONStore
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New Worklight Project

= In Name, type
WeatherProject.

= In Project Templates, select
Hybrid Application.

= Click Next.

8 00 New Worklight Project

Worklight Project

Create a new Worklight project.

v

Mame:| | WeatherProject

Project Templates:

E Inner Application
O Native API

|E| Shared Templates
Shell Component

o] Hybrid Application Hybrid Applicaticn

Creates a Worklight project containing an
initial Hybrid application. A Hybrid
application can target multiple
environments and is primarily written in
HTMLS, C55, IS, but can be extended with
native code. It can access device
capabilities through a JavaScript AP

@ < Back [

Next > ] |  cancel | Finish
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New Hybrid Application

= In Application name, type
Weather.

= Select Use Worklight
Application Framework
(beta).

— Dojo Toolkit is selected
automatically because IBM
Worklight Application

Framework is based on Dojo.

= Click Finish.

= If the Open Associated
Perspective dialog box opens,
click No.

800

MNew Worklight Project

Hybrid Application

Configure the hybrid application that will be created along with the

Worklight project.

@ Hybrid Application

Application name:

Weather|

Optional JavaScript Libraries: Dojo Toolkit

| Configure JavaScript Libraries... |

w

Lg Use Worklight Application Framework (beta)

| Configure Framework Library... |

@ A separate project called "wiFrameworkLib” will be created

< Back | Next > | Cancel

[

Finish

]
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What Was Created in the Workspace?

= Worklight project
WeatherProject (1).

— Hybrid application Weather
(2).
- application. jsonfile: the
application model (3).

- view.html file: the
application Ul (4).

- messages. js file: the
application Ul labels (5).

* dojoLib project: Dojo Toolkit
library (6).
= wlFrameworkLib project: IBM

Worklight Application
Framework library (7).

[ Project Explorer 53 == ¥ =g
O 2]

¥ WeatherProject T
b =2 Java Resources
b =i, JavaScript Resources
P = adapters
“F\ apps
¥ = Weather
' ¥ = common
b= css
P = images
P =js

Eapplication—descriptnr.xml
build-dojo.properties
|X| build-dojo.xmi
Ehuild—setti ngs.xml

P = bin

b = externalserverLibraries

P (= server

b (= services

b

@I > ;ﬁwl FrameworkLib |
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The IBM Worklight Application Framework Editor

When you create a new hybrid application that uses IBM Worklight
Application Framework, the editor of IBM Worklight Application
Framework opens.

Use this editor to edit the application. json andthe view.html
files of your app.

If you close the editor, double-click the application. json file to
open it again.

The editor has three tabs (see the next slide):

Application is used to specify the general configurations of your
app.

Data Objects is used to define the data objects of your app, and
how the data maps to the back-end services.

Views is used to define your app views (screens) and the
transitions between them.
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The IBM Worklight Application Framework Editor

application.json &3

Worklight Application Framework editor

| Preview | Edit HTML

Getting started with Worklight Application Framework

SELECT SERVICES

Services, like SOAP or SAP, provide a gateway
to your backend data.

b Theme

b Application Level Events

b Motifications

Application | Data Objects | Views

CREATE A DATA OBJECT CREATE A VIEW

Data Objects communicate with services to Wiews display your data to the user and
retrieve or send data and keep that data for invoke acticns on the Data Objects.
your application.

CREATE A DATA OBJECT CREATE A VIEW

b Authentication
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Creating a project with a hybrid application

Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view

Deploying and previewing
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Weather Application Overview

11

You build a weather app.

The app has three views
(screens), as shown on the right.

The Home view does not access
any back-end service. This view
IS used to enter the ZIP code of a
city.

The Weather and Forecast
views pull the data for the
requested ZIP code from back-
end services.

The app uses a public weather
Web Service:
http://wiki.cdyne.com/index.php/C
DYNE_Weather

City
State
Temperature
Description
ZIP 10007 >
Show Weather >
Show Forecast > Eararsat

New York

ity
State

Forecast

12/10/13, 12:(

121113, 12:0

12/12/13, 12:(

From the Home view, the user can either
go to the Weather view or to the
Forecast view.
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Creating a project with a hybrid application
Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view

Deploying and previewing
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Data Object of the Home View

13

Create a data model and a
view.

You can create the view first,
or you can create the data
model first. In this tutorial, you
create the data model first.

In the section Getting started
with Worklight Application
Framework of the Application
tab, click CREATE A DATA
OBJECT.

In Data object name, type
Home.

Select Do not import
attributes and click Finish.

Getting started with Worklight Application Framework

- NaNs) Create a Data Object

Data Object
Create a new Data Object

Data object name:

Home|

_ Import attributes from a service

& <New Service>

(=) Do not import attributes

(‘E’:l | Help | < Back Next > | Cancel | [ Finish ]
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Adding a Data Attribute

14

Create a data attribute to store
the ZIP code that the user of
the app will enter.

Right-click the Home data
object, and select New. The
“Add New field” window opens.

In Name, type: zip

In Data type, select String, and
click Finish.

*application.json &3

Worklight Application Framework editor

= X

Data Object Definitions
B global

5] zip
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Creating the Home View

15

In the section Getting started with
Worklight Application
Framework of the Application tab,
click CREATE A VIEW.

In Name and Heading, type Home.

= Note: Name is used to identify
the view in the editor, Heading

IS displayed in the application Ul.

In The view deals with the
following data object select
Home, and click Next.

In the column Editable of the table,
select the check box to make the
zip view element editable and click
Finish.

The Views tab opens and displays
the created Home view.

Getting started with Worklight Application Framework

SELECT SERVICES CREATE A DATA OBJECT

*application.json 22

Worklight Application Framework editor

ﬂ Home

Section

=] zip O
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Creating a project with a hybrid application
Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view

Deploying and previewing
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Creating the Weather Data Object

17

Create the Weather data object

based on an existing web
service.

Switch back to the Application

tab.

In the section Getting started
with Worklight Application
Framework, click CREATE A
DATA OBJECT.

In Data object name, type
Weather.

Select Import attributes from
service, <New Service>, and
click Next.

Getting started with Worklight Application Framework

[ Nals) Create a Data Object

Data Object

Create a new Data Object

Data object name:

‘Weather

() Import attributes from a service

17 <New Service=

() Do not import attributes

If?:l | Help | < Back [ Next> ] | Cancel | Finish
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Service Discovery

18

In the Service type list, select
Web Service Definition
Language (WSDL).

Copy the following URL, and
paste it into the URL field:
http://wsf.cdyne.com/Weat
herWS/Weather.asmx?wsdl.

Click Go.

In Select Service (lower left),
expand WeatherSoap12, and
select GetCityWeatherByZIP.

Browse the Details section
(lower right) to find out more
about the service.

Click Next.

800

Create a Data Object

Back-end Service

Add a back-end service to invoke from the mobile application

Service type: | web Service Definition Language (WSDL)

(*) URL:

[ http: / fwsf.cdyne.com [WeatherWs /Weather.asmx?wsdl

() File:

Select Service:

®@

v %’WeatherSoaplZ

& Getweatherinformation
o I

4 GetCityWeatherByZIP
El

Weathersoap

4 GetWeatherinfarmation
& GetCityForecastByZIP
£} GetCityWeatherByZIP

Details

u to get your City's Weather, which
is updated hourly. U.5. Only

Allows yo

¥ &7 GetCityWeatherByZIP
¥ == input
¥ {} GetCityWeatherByZIP

¥ <= output
¥ {} GetCityWeatherByZIPResponse

=z

¥ {} GetCityWeatherByZIPResult
[ City
[=] Description
[=Pressure
[=] RelativeHumidity
[F]Remarks
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Data Attributes

= Define the data attributes to
create, based on the service
Inputs and outputs.

= Select City, Description,
State, and Temperature under
output (as shown on the right).

= Click Next.

19

800

Create a Data Object

Data Fields

Select the service inputs and outputs to import. For each input and output, choose the data
type to create, and the format for type conversion.

Service

=] ¥ &% GetCityWeatherByZIP

v

v

METnmD

=

input
CetCityWeatherByZIP
ZIP

¥ <= output
¥ {} GetCityWeatherByZIPResponse

¥ {} GetCityWeatherByZIPResult

Ecity

=] Description
Pressure
RelativeHumidity
Remarks
ResponseText

[=7] state
Success

[E] Temperature
Visibiliny
WeatherlD
WeatherStationCity
Wind
WindChill

| Help | | < Back

Data Type Format

String
String

String

String

| |

| Select all |

| Clearall |

WJ | Ccancel |

Finish
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Data Operation

In addition to attributes, data
objects have operations. The
application uses operations to
Interact with back-end services
via adapters. Operations define
the mappings between the data
attributes and the service inputs
and outputs.

Select retrieve (retrieve a
single data record from the
back-end).

Click Finish.

20

800 Create a Data Object

Data Operation

Choose the service operation to implement

The application will use the service to perform tasks on the data that is displayed in the user
interface. Specify what type of data operation provided by the service you want to use.

|_J)create (create data in the back-end)

I (E} retrieve (retrieve a single data record from the back-end) |

| update (update a single data record in the back-end)
() delete (delete data from the back-end)
[ query {retrieve a list of data from the back-end)

() custom (for instance “search”)

I'G_?:I Help < Back MNext > Cancel [ Finish J
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Created Data Object

= The editor switches to the Data
Objects tab.

= Based on your selections, the
Weather data object was
created.

= It replicates the structure of the

GetCityWeatherByZIP service.

21

Data Object Definitions

> & global
B Home
¥ {} CetCityWeatherByZIPResult
(=] City
['s"] Description
[s"] State

[5] Temperature
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Created Operation

22

According to your selection, a
retrieve operation is associated with
the Weather data object.

The service outputs that you selected
previously are mapped to the data
attributes.

The service requires ZIP as input.
Create a global variable and map it to
the service input: drag ZIP from the
Service (right) side to global on the
Data (left) side.

You will later assign the ZIP code
entered by the user to this global
variable.

Events |
Operations used for views to get things done:
'Operation Service
S e |
update
delete
create
query

Operation Details

Click and drag data ohject items onto service elements to create a connection
Data Service
v E global ¥ X GetCityWeatherByZIP
[S1DATE ¥ = input
= ey ByZIP
[57USER_NAME =lzip
[2] 2P ¥ <= output
E - T AL ByZIPResponse
¥ {} GetCityWeatherByZIPResult ¥ {} GetCityWeatherByZIPResult

[ECity

[ Descr

[=]state

iption

[=] Temperature

[ECity

[=] Description
[ElPressure

[ RelativeHumidity
[EIRemarks
[F]ResponseText
[Estate

livge Success
[ETemperature
[Evisibility
[ElWeatherlD
[=weatherStationCity
[=Iwind
[EIwindChill
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Discovered Service

23

= The discovered services are in
the services folder of the
Worklight project.

= Expand the services folder to
see the GetCityWeatherByZIP
service.

[ Project Explorer 52 = = E=S

b 28 dojoLib
i ﬁWEathe rProject

b =0 Java Resources

b =, JavaScript Resources

b = adapters

b =-apps

b = hin

P = externalServerLibraries
b (= server

¥ i services

=4

{ e |

w 4% CetCityWeatherByZIP
¥ = input
¥ {} CetCityWeatherByZIP
=lzip
¥ <= output

[="] City
[*5] Description
[5]Pressure

[l Remarks

[ ResponseText
[5]5tate

g Success

[l Temperature
(=] Visibility

(=l weatherlD

(=] wind
[E]WindChill

[5] RelativeHumidity

[FlWeatherStationCity

¥ {} CetCityWeatherByZIPResponse
¥ {} CetCityWeatherByZIPResult
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Generated Adapter

24

To invoke the back-end service,
an adapter was automatically
generated for your application.

The new adapter is in the
adapters folder. The name of the
adapter is SoapAdapterl.

This adapter is used whenever
the application needs to access
back-end services.

In this particular case, you set up
the Weather view to call the data
object retrieve operation when
the view opens. The operation
invokes the

Weather_ GetCityWeatherByZIP
procedure of this adapter.

. i =

™5 Project Explorer &3 = <}==t> = 0O
b 24 dojolib
v f)WeatherProject

P =2 Java Resources

P =0 JavaScript Resources

¥ = adapters

¥ = SoapAdapterl

¥ SpapAdapterl-impl.js

@ buildBody{params, namespaces, mappings, soapEnvis)
@ getAttributes(jsonObj)
@ handleMappings{jsonQbj, type, mappings)

@ invokeWebService(body, headers, soapAction)
@ jsonToXml{jsonObj, xmli5tr, namespaces)

@ xmlEscapelobj)
ﬁ SpapAdapterl.xml
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Creating the Weather View

= You discovered a service and
created a data object based on
Its outputs.

= Now, create a view by using
this data object as a template.

= Go back to the Application tab
and click CREATE A VIEW.

25

Getting started with Worklight Application Framework

[

SELECT SERVICES CREATE A DATA OBJECT CREATE A VIEW

like SOAP or SAP, provide a gateway
1o your backend data.
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Creating the Weather View

= In Name and Heading, type:
Weather.

= In The view deals with the
following data object, select
Weather.

= The view will represent this data
object. The view elements will
be created based on the
attributes of this data object.

= Select retrieve from the
Operation list, and click Next.
This operation will be called
when the view opens.

26

800 Add View

View
Create a new View

Narme:

‘Weather

Heading:

Weather

The view deals with the following data object:

-- Mo Data Object -~

E' Home

When the view is shown, invoke an operation on the selected data object to obtain the data to
display:

Operation: | retrieve .

< Back |  Next> | | Cancel | [ Finish J

@:I | Help |

© Copyright International Business Machines Corporation 2014. All rights reserved.



Configuring the View Elements

27

= You create the view elements
that are listed in the table.

= In the first column, you can
clear check boxes for elements
that you do not want to create.
For this view, create all
elements.

= Reorder the elements as
follows by clicking Up or Down:
City, State, Temperature,
Description.

= Click Finish.

e s

S 0

Add View

Import data object attributes into the new view

Select view elements to create. For each view element choose its type and define
whether it is editable. Configure the details views for table elements.

[ | Wiew element name [View element type Editable
V| City String Field g~
| State String Field .;J
T reroersire | /0 M
v'| Description String Field ./rJ
|/'?‘:| | Help || < Back | Mext > | Cancel |

[

| Up |

| Down |

Finish

J
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Created View

= The Views tab opens and
displays the created Weather
view.

= The view has a section that
contains the elements that you
selected.

28

*application.json 23

Worklight Application Framework editor

"t Home Weather
Sactio Saction

[ zip O =] city

[5] State

[] Temperature

[5] Description

o000
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Creating a Transition from the Home View to the Weather View

29

First, create a button that triggers

the transition.

Drag Section from the Palette
on the right to the Home view.
Leave Name and Label empty
and click OK.

Drag Action from the Palette to
the new Section.

In Name, type showWeather, in
Label, type Show Weather and
click Finish.

Create a transition from the new
showWeather button, by
dragging the circle in front of it to
the Weather view.

*application.json 23

Worklight Application Framework editor

Weather

Section

e

City

State

Temperature

EEE
OROROX®)

= showWeathaer

Description
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Configuring the Transition

Double-click the transition to
configure it. The Configure
Transition wizard opens.

At the bottom of the window, you
can see the section Specify how
the data from the source view is
mapped to data in the target
view.

Map (drag) the zip attribute of the
source view data object (on the left)
to the global variable ZIP (on the
right) that was created earlier.

When the transition happens, the
value of the zip attribute is
assigned to the global variable ZIP.

Click OK to close the window.

30

800

Configure Transition

Configure Transition

Specify the transition target and how data should be transferred to the target view.

Should any of the Data Object instances in the "from” view be re-used in the "to" view?

Re-use In Target View: Target Data Object
Mo data objects with the same type in targe...

'Data Object Instances
Home (Type Home)

Specify how the data from the source view is mapped to data in the target view

Data objects in "Home" View Data objects in "Weather” View

v £ global
[F1DATE

[FUSER_ID
CElUSER_KAME

v E global
[FlDATE

[EIUsSER_ID
CElUSER _RAKME

[7] zIP
¥ I Weather (Type Weather)
¥ {} CetCityWeatherByZIPResult
[FlCity

= zir

¥ B Home {Type Home)

[F]Description
[=]state
(5 Temperature

| Cancel | [ OK

J
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Agenda

Creating a project with a hybrid application
Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view

Deploying and previewing
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Creating the Forecast Data Object

32

Create the Forecast data object
based on an existing web service:

=Switch back to the Application
tab.

*In the section Getting started
with Worklight Application
Framework, click CREATE A
DATA OBJECT.

*In Data object name, type
Forecast.

=Select Import attributes from
service, <New Service>, and
click Next.

Getting started with Worklight Application Framework

800 Create a Data Object

Data Object

Create a new Data Object

Data object name:

Forecast

() Import attributes from a service

<New Service>

&7 GetCityWeatherByZIP

I._;_.I Do not import attributes

("_?k‘l | Help | < Back [ Next > ] | Cancel | Finish
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Service Discovery

33

In Service type, select Web Service
Definition Language (WSDL).

Select the URL you used previously
in the URL list, and click Go.

In the Select Service section (lower
left), expand WeatherSoap12, and
select GetCityForecastByZIP.

Browse the Details section (lower
right) to find out more about the
service.

Click Next.

800

Create a Data Object

Back-end Service

Add a back-end service to invoke from the mobile application

Service type: | web Service Definition Language (WSDL)

(®) URL:

http:/ fwsf.cdyne.com /WeatherWs /Weather.asmx?wsd|

*| | Go |

() File:

Workspace File System

Select Service: Y%WeatherSoaplZ
85 et W e athe

% GetCityForecastByZIP
9@ CetCityWeatherByZIP
¥ 25 WeatherSoap

8 CetWeatherinformation
ﬁ CetCityForecastByZIP
8 CetCityWeatherByZIP

Details

Allows you to get your City Forecast Over the
Next 7 Days, which is updated hourly. U.5. Only
¥ &% GetCityForecastByZIP
¥ =>input
¥ {} GetCityForecastByZIP
=z
¥ <= output
¥ {} GetCityForecastByZIPResponse
¥ {} GetCityForecastByZIPResult
(=] City
¥ {} ForecastResult
¥ [ ] Forecast
= Nara

@ [ help | |

< Back | [ Mext > ] |

Cancel | Finish
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Data Attributes

= Define the data attributes to
create, based on the service
Inputs and outputs.

= Select City, Date, Description,
DaytimeHigh, MorningLow,
and State under output (as
shown on the right).

= Click Next.

34

800 Create a Data Object
Data Fields
Select the service inputs and outputs to import. For each input and output, choose the data
type to create, and the format for type conversion.
[Service Data Type Format ' IMI
B CaCmroecastyzp |||
O ¥ =} input | Clearall |
v CetCityForecastByZIP

[ ] ZIp
= ¥ <= output
= ¥ {} GetCityForecastByZIPResponse
= ¥ {} GetCityForecastByZIPResult
) = City String
= ¥ {} ForecastResult
= ¥ [] Forecast
=) FU Date Timestamp
) [=]Desciption String

v ProbabilityOfPrecip. ..
] Daytime

Nighttirme
) ¥ {} Temperatures
7)) [ DaytimeHigh String
i [FlMorningLow String
WeatherlD

L ResponseText
7)) [ state String
- Success

WeatherStationCity
@:l | Help | | < Back | [ Mext = ] | Cancel | Finish
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35

Data Operation

= Select the data operation that is
used to invoke the service.

= Select retrieve (retrieve a

single datarecord from the
back-end).

= Click Finish.

8 00 Create a Data Object

Data Operation

Choose the service operation to implement

The application will use the service to perform tasks on the data that is displayed in the user
interface. Specify what type of data operation provided by the service you want to use.

_ create (create data in the back-end)

I {E} retrieve (retrieve a single data record from the back-end} I

_ update (update a single data record in the back-end)
_ delete (delete data from the back-end)
_ query (retrieve a list of data from the back-end)

| _ | custom (for instance “search”)

@:I | Help | | =< Back | Mext > |  Cancel | [ Finish

J
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Created Data Object

36

= The editor switches to the Data
Objects tab.

= Based on your selections, the
Forecast data object was
created.

= It replicates the structure of the
GetCityForecastByZIP
service.

B X

[+

Data Object Definitions

| E " global

¥ {} GetCityForecastByZIPResult
(5] City
¥ {} ForecastResult
¥ | | Forecast
EFJ Date
['s*] Desciption
¥ {} Temperatures
5] DaytimeHigh
5] MorningLow
[5"] State

& Home
b & Weather
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Created Operation

37

According to your selection, a
retrieve operation is associated
with the Forecast data object.

The service outputs that you
selected previously are mapped
to the data attributes.

The service requires ZIP as an
input. Drag ZIP from the
Service (right) side to ZIP on
the Data (left) side, to map the
global variable to the service
input.

Operations used for views to get things done:

retrieve

Service
GetCityForecastByZIP ]

pacs
¥ {} CetCityForecastByZIPResult
[ City
¥ {} ForecastResult
¥ [] Forecast
Y Date
[=] Desciption
¥ {} Temperatures
[=7] DaytimeHigh
[=IMorningLow
[=state

U PETECISRy ZIPResponse
¥ {} CetCityForecastByZIPResult
= City
¥ {} ForecastResult
¥ [] Forecast
Y Date
[=] Desciption
¥ {} ProbabilityOfPrecipiation
(=] Daytime
[=INighttime
¥ {} Temperatures
[=] DaytimeHigh
[=]MorningLow
[EweatheriD
[5] ResponseText
[=state
i Success

[ WeatherStatienCit, ¥
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Discovered Service and Generated Adapter Procedure

38

= The discovered
GetCityForecastByZIP service
IS placed in the services folder
of the Worklight project.

= To invoke the back-end service,

a new procedure is generated
In SoapAdapterl.

[ Project Explorer 83 = <‘}==b | v =g
b 2 dojolib
‘FﬁWeatherPrﬁject

b =i Java Resources

b =3, JavaScript Resources

¥ (= adapters

¥ = SpapAdapterl
v SoapAdapterl-impl.js

@ buildBody{params, namespaces, mappings, soapEnvNs)
@ getAttributes(jsonOhbj)
@ handleMappings{jsonObj, type, mappings)
@ inmkeWebSemcE(h ody, headers, soapAction)

@ xmlEscape(nbﬂ
ﬁ SoapAdapterl.xml
b i=apps
P (= hin
b = externalserverlibraries
b = server
¥ oL gervices,

P e
[ E;wal FrameworkLib
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Creating the Forecast View

= GO0 back to the Application tab
and click CREATE A VIEW.

= In Name and Heading, type
Forecast.

= In The view deals with the
following data object, select
Forecast.

= Select retrieve in the
Operation list, and click Next.

39

800 Add View

View
Create a new View

ame:
Forecast
Heading:
Forecast

The view deals with the following data object:

-- No Data Object --

' Home
& Weather

When the view is shown, invoke an operation on the selected data object to obtain the data to
display:

Operation: | retrieve

@:I | Help | < Back | Mext= | | Cancel | [ Finish J
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Configuring the View Elements

= Reorder the elements as

8006

Add View

follows by clicking Up or Down:
City, State, Forecast.

Import data object attributes into the new view

Select view elements to create. For each view element choose its type and define
whether it is editable. Configure the details views for table elements.

View element name View element type | Editable [ up |
City tring Field & O
;0 m (Coomn ]
Forecast “able Field B O
("_?j | Help | |  <Back | Next > | Cancel | [ Finish ]

40
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Configuring the Table Element

41

Click the Forecast row, and
click the “...” button in the View
element type column.

Reorder the elements as
follows by clicking Up or
Down: Date, DaytimeHigh,
MorningLow, Description.

Click Finish to close the
window.

Click Finish to close the Add
View wizard.

800 Add View

Import data object attributes into the new view

Select view elements to create. For each view element choose its type and define
whether it is editable. Configure the details views for table elements.

[ I | wiew element name View element type  Editable '| up |

/] |City String Field Fa
| | State String Field - Down
800
Import data object attributes into the new view
Select view elements to create. For each view element choose its type and
define whether it is editable. Configure the details views for table
elements
v [ Wiew element name Wiew element type Editable ' [ up |
v Date imestamp Field .frJ -
| DaytimeHigh ring Field y | _Down |
- /0 M
+'| Desciption ring Field F 2
@:I | cancel | [ Finish |

© Copyright International Business Machines Corporation 2014. All rights reserved.




Created Views

42

The Views tab opens and
displays the created views.

The Forecast view shows City,
State, and the Forecast table.

The Forecast table has four
attributes. On a small device, the

table can show only two columns.

To show all four attributes,
another view was created —
Forecast-Forecast (the
concatenation of the name of the
first view and the field name of its
table).

This Forecast-Forecast view
opens when you tap the row of
the table in the running
application.

Forecast

Saction
(] City
=]

State

Eﬂ Forecast

OO

Forecast-Forecast

E E M@

Section
Date
CaytimeaHigh
MomingLow

Desciption

ORORORE)
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Creating a Transition from Home View to Forecast View
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First, create a button that triggers
the transition.

Drag Section from the Palette on
the right to the Home view. Leave
Name and Label empty and click
OK.

Drag Action from the Palette to
the new Section.

In Name, type showForecast, Iin
Label, type Show Forecast and
click Finish.

Create a transition from the new
showForecast button, by dragging
the circle in front of it to the
Forecast view.

£} Home
Sectio
= = O
Section
= Neath O
Section
= Forecast On

Weather

Section

(5] city
[¥] State

['5"] Temperature
[5"] Dascription

Forecast

Saction

(=] city
[5"] State

BH Forecast

o000

OO
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Configuring the Transition

= Double-click the created transition to
configure it. The Configure
Transition wizard opens.

= At the bottom of the window, you can
see the Specify how the data from
the source view is mapped to data
in the target view section.

= Map (drag) the zip attribute of the
data object in the source view (on the
left) to the global variable ZIP (on the
right).

= When you run the application, the
value of the zip attribute is
assigned to the global variable ZIP.

= Click OK to close the window.

44

800 Configure Transition

Configure Transition

Specify the transition target and how data should be transferred to the target view.

Should any of the Data Object instances in the "from” view be re-used in the "te" view?

'Data Object Instances Re-use In Target View: Target Data Object
Home (Type Home) Mo data objects with the same type in targe...

Specify how the data from the source view is mapped to data in the target view
Data objects in "Home" View Data objects in "Forecast” View
¥ E global ¥E global
] DATE [=] DATE
[lUsER_ID [FlUsER_ID
[ USER_NAME [F]USER_NAME
7] zIP 2] zIP
¥ I Home (Type Home) ¥ [ Forecast (Type Forecast)
¥ {} GetCityForecastByZIPResult
[F]City
¥ {} ForecastResult
¥ [] Forecast
B Date
[E]Desciption
¥ {} Temperatures
[¥] DaytimeHigh
[ MorningLow
[¥]state
|  Cancel | [ oK ]
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Agenda

Creating a project with a hybrid application
Weather application overview

Building the Home view

Building the Weather view

Building the Forecast view

Deploying and previewing
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Deploying and Previewing

Your application is ready.
Save the file (Ctrl-S).

CI|Ck PI‘eVieW N the uppel‘- [ application.json &2
”ght corner Of the edltor Worklight Application Framework editor Preview Edit HTML

The following actions are
then triggered:

The Worklight server
starts.

The app is deployed.

[-NaNa! Adapter deployment

The adapter is deployed (a P T e
message opens to inform

you about it; click OK to | “
close it).

The app opensin a
browser.
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Previewing the Application

47

The first view (Home) of the
application opens.

Click ZIP to type the ZIP code.

A view that contains a data
entry field opens.

Type, for example, 10007.

Click Home in the application
header to get back to the Home
view.

K
]

® 00 Weather

C [} 9.148.16.162:10080/W... [[J57| »

e, e e,

Zip 10007 »
Show Weather >
Show Forecast >
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Previewing the Application

48

Click Show Weather.

The second view (Weather) of
the application opens.

The data that is shown on this
view is the result of the back-
end service invocation.

Click Home in the application
header to get back to the Home
view.

|
® 00 Weather * %

K

C [} 9.148.16.162:10080/W... [[J 7% »

City New York
State NY
Temperature 64
Description Cloudy
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Previewing the Application

49

Click Show Forecast.

The third view (Forecast) of the
application opens.

The data that is shown on this
view Is the result of the back-
end service invocation.

To see more details about a
specific date, click the
corresponding row in the
Forecast table.

Click Home in the application
header to get back to the Home
view.

® 0 O Weather % G i
C [ 9.148.16.162:10080/W... Tel 2| =
City New York
State NY
Forecast
2014-05-03 00:00 65 ©
2014-05-04 00:00 62 ©
2014-05-05 00:00 62 ©
2014-05-06 00:00 64 ©
2014-05-07 00:00 66 ©
2014-05-08 00:00 65 ©
2014-05-09 00:00 71©
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Wrap-up

50

You created a simple hybrid mobile application.
The application interacts with a public Web Service to get the data.

The adapter that invokes the Web Service was automatically generated for your
application.

By using IBM Worklight Application Framework, you created the application data
representation and the views without writing any code.

Notes:

To run the application on a device, you must create an IBM Worklight
environment for each platform. For more information about specific devices,
see the modules Previewing your application on <platform_name> under
category 2, Hello Worklight, of the tutorials and samples.

If you import the sample project that is provided with this tutorial, make sure
that you have dojoLib and wiFrameworkLib in your Eclipse workspace.
These projects are created automatically when you create a hybrid application
that uses IBM Worklight Application Framework.
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For more information

For more information about IBM Worklight Application Framework,
see the see the user documentation at:
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http://ibm.biz/knowctrSSZH4A_6.2.0/com.ibm.worklight.dev.doc/dev/c_creating_hybrid_app_af.html

Notices
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Permission for the use of these publications is granted subject to these terms and conditions.
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:
- IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

- Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer
of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this one)
and (ii) the mutual use of the information which has been exchanged, should contact:

- IBM Corporation
Dept F6, Bldg 1
294 Route 100
Somers NY 10589-3216
USA

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice
as follows:

- © (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. _enter the year or years_. All rights reserved.

Privacy Policy Considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
session information (generated by the application server). These cookies contain no personally identifiable
information and are required for session management. Additionally, persistent cookies may be randomly
generated to recognize and manage anonymous users. These cookies also contain no personally
identifiable information and are required.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent. For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at and IBM’s Online Privacy
Statement at the sections entitled “Cookies, Web Beacons and Other
Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at
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http://www.ibm.com/privacy
http://www.ibm.com/privacy/details
http://www.ibm.com/software/info/product-privacy

Support and comments
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For the entire IBM Worklight documentation set, training material and online forums where you can post questions, see the IBM website at:

Support

Software Subscription and Support (also referred to as Software Maintenance) is included with licenses purchased through Passport
Advantage and Passport Advantage Express. For additional information about the International Passport Advantage Agreement and the
IBM International Passport Advantage Express Agreement, visit the Passport Advantage website at:

If you have a Software Subscription and Support in effect, IBM provides you assistance for your routine, short duration installation and
usage (how-to) questions, and code-related questions. For additional details, consult your IBM Software Support Handbook at:

Comments

We appreciate your comments about this publication. Please comment on specific errors or omissions, accuracy, organization, subject
matter, or completeness of this document. The comments you send should pertain to only the information in this manual or product and
the way in which the information is presented.

For technical questions and information about products and prices, please contact your IBM branch office, your IBM business partner,
or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any way it believes
appropriate without incurring any obligation to you. IBM or any other organizations will only use the personal information that you supply
to contact you about the issues that you state.

Thank you for your support.
Submit your comments in the IBM Worklight Developer Edition support community at:

If you would like a response from IBM, please provide the following information:
Name
Address
Company or Organization
Phone No.
Email address
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http://www.ibm.com/mobile-docs
http://www.ibm.com/software/passportadvantage
http://www.ibm.com/support/handbook
https://www.ibm.com/developerworks/mobile/worklight/connect.html
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